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SAR TEST REPORT

Report Number: M120917R_FCC_MCB8355 SAR_GSM-UMTS
WWAN FCC ID: EJE-MC8355D IC: 337J-MC8355D

1.0 GENERAL INFORMATION

Table 1

Test Sample:

Radio Module Under Test:
Interface Type:

Device Category:

Test Device:

Host PC model:

WWAN FCC ID:

WWAN IC:

RF exposure Category:

Manufacturer:

Test Standard/s:

Statement Of Compliance:

Test Dates:

Test Officer:

Authorised Signature:

Fujitsu Stylistic Q series Tablet PC
MC8355

Mini-PCIl Module

Portable Transmitter
Pre-Production Unit

Q702

EJE-MC8355D

337J-MC8355D
General Population/Uncontrolled

Fujitsu Limited

Evaluating Compliance with FCC Guidelines For Human Exposure to
Radiofrequency Electromagnetic Fields

Supplement C (Edition 01-01) to OET Bulletin 65 (Edition 97-01)
Radio Frequency Exposure Compliance of Radiocommunication
Apparatus (All Frequency Bands)

RSS-102

EN 62209-2:2010

Human exposure to radio frequency fields from hand-held and body-
mounted wireless communication devices. Human models,
instrumentation, and procedures.

Part 2: Procedure to determine the specific absorption rate (SAR) for
wireless communication devices used in close proximity to the human
body (frequency range of 30 MHz to 6 GHz)

IEEE 1528: 2003

Recommended Practice for Determining the Peak Spatial-Average Specific
Absorption Rate (SAR) in the Human Head Due to Wireless Communications
Devices: Measurement Techniques.

The Fujitsu Tablet Computer Q702 with Sierra Wireless
GSM/UMTS/EVDO Module MC8355 complied* with the FCC General
public/uncontrolled RF exposure limits of 1.6mW/g per requirements
of 47CFR2.1093(d). It also complied with IC RSS-102 requirements.

3™ October to 9™ November 2012

/.{Z‘“L (e i<

Peter Jakubiec

é..

Chris Zombolas
Technical Director
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\ included in this document are traceable to Australian/national standards. NATA is a signatory to the ILAC
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SAR TEST REPORT
Portable Tablet Computer
Model: Q702
Report Number: M120917R_FCC_MC8355 SAR_GSM-UMTS

2.0 INTRODUCTION

Testing was performed on the Fujitsu Tablet PC, Model: Q702 with SIERRA Mini-PCI Wireless WAN Module
(Gobi 3000), Model: MC8355, with Intel Mini-PCI Wireless LAN Module ( 802.11a/b/g/n), and Broadcom
Bluetooth Module, Model: BCM92070MD_REF6. Bluetooth Transmitter nominal power is less than 5mW. The
Gobi 3000 module is an OEM product. The Mini-PCI Wireless WAN (WWAN) was tested in the dedicated host
— STYLISTIC Q series, Model Q702. The system tested will be referred to as the DUT throughout this report.

2.1 Product Features

a. G- Sensor is implemented to enable power reduction based upon tilting angle of slate PC and
viewing positions. Sierra WWAN module Gobi3000 (MC8355) has Dynamic Power Control
(DPC) RF output power reduction.

Overall dimension of slate PC: 302 mm x 195mm (with 11.7 inches LCD size )
. Does not support Hot spot / Tethering functionality.

d. WWAN Module : Sierra Gobi3000, Original FCC ID: N7NMC8355 submitted as

Fujitsu FCC ID: EJE-MC8355D
i. Part22/24 (No LTE)

1. Frequency band: Cellular/PCS and AWS band
2. GSM/GPRS / EDGE / UMTS/HSPA+

a) GPRS/EDGE Class 10

b) HSDPARel 7 / Cat 10

c) HSUPARel6Cat6

3. CDMA 2000
a) 1x  b)EVDO Release 0 and A

a. WLAN Module 802.11 a/b/g/n (2x2) : FCC ID: EJE-WL0028 - The WWAN and WLAN
modules will not be able to transmit simultaneously with maximum hand-off duration less than 30
seconds hence simultaneous SAR evaluation is not applied.

b. Bluetooth Module : FCC ID: QDS-BRCM1043

i.  Bluetooth 4.0 + Low power Energy (max 4dBm)

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement
\ included in this document are traceable to Australian/national standards. NATA is a signatory to the ILAC
MNATA Mutual Recognition Arrangement for the mutual recognition of the equivalence of testing, calibration and
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2.3 TEST PLAN

Original FCCID (Qualcomm) J9CGOBI3000
FCC ID established via section 2.933 procedure N7NMC8355
(Sierra)

FCC ID established via section 2.933 procedure as EJE-MC8355D
required for Sensor based tablet PC (Fujitsu)

This application: Class Il Permissive change (Fujitsu) | EJE-MC8355D

2.4 Referenced KDBs

The tests will be performed in accordance with FCC OET Bulletin 65 Supplement C 01-01, IEEE STD
1528-2003, Radio Frequency Exposure Compliance of Radiocommunication Apparatus (All Frequency Bands)
RSS-102 and the following KDB procedures. (pre-25th Oct 2012 released KDBs)

- 941225 D01 SAR test for 3G devices v02
- 941225 D03 SAR Test Reduction GSM/GPRS/EDGE vol
- 447498 D01 Mobile Portable RF Exposure v04

- Power Reduction by sensing (April 2011, Oct 2011 and April 2012 TCBC workshop SAR
Updates )

- Pre-TCB device —specific testing KDB inquiry “Fujitsu FCC KDB 640729 Rev 5” submitted 16th
Nov 2012

2.5 SAR Test Configurations
a. Slate Tablet Mode ( direct contact to flat phantom with 0 mm separation distance )

EDGE# 1 EDGE # 4 EDGE # 3
(Disabled/Tx Off)
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SAR Test NOT performed

RF Tx OFF. Edge.
SAR Test NOT performed

Antto User Distance = 175 mm
SAR Test NOT performed
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2.6 _Summary of Test Configurations

Configuration WWAN Ant-to-User distance SAR Comments
Require
1) Edge 1 WWAN transmitter will be disabled in this Orientation / RF OFF
(1) Edge hence non-functional.
3.0 mm No
Secondary Landscape See section 5 for setup illustration.
(2) Edge 4 SAR evaluation will not be performed for this configuration as this is
] 175 mm No not the most conservative edge. Testing as per KDB 447498 4) b) ii)
Secondary Portrait (2). See section 5 for edge illustration.
(3) Edge 3 SAR evaluation will not be performed for this configuration as this is
_ 182 mm No not the most conservative edge. Testing as per KDB 447498 4) b) ii)
Primary Landscape (2) See section 5 for edge illustration.
(4) Edge 2 SAR evaluation will be performed with the EUT edge in direct contact
) ) 47 mm Yes with phantom flat section. Tested with Full power, DPC mode
Primary Portrait Disabled. (0 mm separation). See Section 5 for setup illustration.
SAR evaluation will be performed with the EUT surface in direct
(5) Edge 5.1 Lapheld contact with phantom flat section. Tested with Power reduction,
6.0 mm Yes . .
Base (Back Surface) DPC mode Enabled. (0 mm separation). See section 5 for setup
illustration.
(6) 6.0 mm SAR evaluation will be performed with the EUT surface parallel to
+ phantom with 5mm spacing as per FCC consultation in pre-TCB
Edge 52 Lapheld ' Yes device-specific testing KDB inquiry “Fujitsu FCC KDB 640729 Rev 5"
Base (Back/Bottom Smm spacing Tested with Full Power, DPC mode Disabled. (5 mm separation).
Surface) See section 5 for setup illustration.
3.0 TEST SAMPLE TECHNICAL INFORMATION
(Information supplied by the client)
3.1 WWAN Details
Table 2
Transmitter: WWAN (UMTS/EVDO combo)
Model Number: MC8355
Manufacturer: SIERRA WIRELESS INC
Network Standard: GSM Release 6 /
UMTS bands : IMT 2100 / 850 / 1900MHz (Band Class I, Il, V)
GSM / EDGE bands: 850 / 900/ 1800 / 1900 MHz
CDMA bands: 850/ 1900 MHz
Channel spacing: 200KHz (GSM), 5MHz (WCDMA)
Channel raster: 200kHz
Antennatype: Main: Monopole, AUX: PIFA

Antenna Manufacturer: NISSEI ELECTRIC CO. LTD.
Antenna Part Number: Main: CP519214, AUX: CP519215

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement
’ included in this document are traceable to Australian/national standards. NATA is a signatory to the ILAC
MNATA Mutual Recognition Arrangement for the mutual recognition of the equivalence of testing, calibration and
g inspection reports.
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Test Signal, Frequency and Output Power

The DUT was provided by Fujitsu Australia Pty Ltd. It was put into operation using a Rohde & Schwarz Radio
Communication Tester CMU200. The channels utilised in the measurements were the traffic channels shown
in the table below. The power level was set to Class 4 for 850 MHz and Class 1 for 1900 MHz GSM bands,
class 3 for 850, 1750 MHz and 1900 MHz UMTS bands Power Class 3 for the 850 MHz (BCO) and Power
Class 2 1900 MHz (BC1) CDMA bands.

Channels and Output power:

Table 3
Frequency Average
Channel and Mode MHz Output Power
dBm
GPRS Mode
Channels 128, 190 and 251 824.2, 836.6 and 848.8 32.6 +/-1 dB
Channels 512, 661 and 810 1850.2, 1880 and1909.8 28.5 +/-0.5dB
UMTS Mode
Channels 4132, 4183 and 4233 826.4, 836.6 and 846.6 23.5+/-0.5dB
Channels 9262, 9400 and 9538 1852.4, 1880 and 1907.6 23 +/- 0.5 dB
Channels 1312, 1427 and 1513 1712.4,1735.4 and 1752.6 22.5+/-0.5dB
CDMA Mode
Channels 1013, 384 and 777 824.7, 836.52 and 848.31 24 +/-1dB
Channels 25, 600 and 1175 1851.25, 1880 and 1908.75 23+/- 0.5 dB

3.3 DUT (Notebook PC) Details

The intention of this application is to certify WWAN module FCC ID: EJE-MC8355D and IC: 337J-MC8355D in
a Fujitsu host PC model Q702 with WLAN model Intel 62205ANHMW AND Bluetooth model
BCM92070MD_REF®6.

SAR testing was conducted on the sample that is also equipped with the Bluetooth transmitter with antenna
and Intel WLAN modules with antenna.

According to the manufacturer specifications the Bluetooth is a low power transmitter (4dBm), also Bluetooth
Antenna is located >5cms from any other antenna in the system. The Antenna location is shown on page 5 of
the report

Table 4
Host notebook : STYLISTIC Q series
Model Name: Q702
Serial Number: Pre-production Sample
Manufacturer: FUJITSU LIMITED
CPU Type and Speed: Core i5 1.8GHz
LCD 11.7"WXGA(1280x800 : LP116WH4
Graphics chip None
Wired LAN: None
Modem: None
Port Replicator Model: FPCPR199
AC Adapter Model: 60W: PXW1931N
Voltage: 19V
Current Specs: 3.16A
Watts: 60W

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement
included in this document are traceable to Australian/national standards. NATA is a signatory to the ILAC
MNATA Mutual Recognition Arrangement for the mutual recognition of the equivalence of testing, calibration and
inspection reports.
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3.4 Test sample Accessories

3.4.1 Battery Types
One type of Fuijitsu Lithium lon battery is used to power the DUT.

Standard Battery

Table 5
Model Li-ion
V/mAh 10.8V/6700mAh

4.0 TEST SIGNAL, FREQUENCY AND OUTPUT POWER

For the SAR measurements the DUT was operating at full transmit power. The fixed frequency channels used
in the testing are shown in Table Below.

The frequency span of the GSM and UMTS bands was more than 10MHz consequently; the SAR levels of the
test sample were measured for lowest, centre and highest channels in the applicable modes. There were no
wires or other connections to the DUT during the SAR measurements.

At the beginning of the SAR tests, the conducted power of the DUT was measured after temporary modification
of antenna connector inside the DUT’s TX RX compartment. Measurements were performed with a calibrated
Power Meter. The results of this measurement are listed in tables below. Burst Average power was used to
calculate the Frame Average power (100% Duty Cycle) which determines the worst case Multislot Class.

Gobi3000 - IMEI — 357485040145726 0dB Power Reduction
Conducted Power Measurement CDMA 2000 1xRTT 850/1900 MHz

Configuration:
Network > System Parameters > System ID = 2004; Network Identity > Network ID Number = 65535

Service cfg > Primary Service Class > Selected Service = Loopback Service; Primary Service Class >
Loopback Service > Selected Service Option = Service Option x (x - 2, 9 or 55); Service Option x (x- 2, 9 or
55) > FCH Config > Frames > Frame Rate = Full; Selected Service Option > Service Option 55 > FCH Config >
FCH > F-FCH-MO = 0001hex (Fundamental Channel Test Mode 1) or 0002hex (Fundamental Channel Test Mode 2)

Service cfg > Primary Service Class > Selected Service = Test Data Service; Primary Service Class > Test
Data Service > Selected Service Option = Service Option 32; Test Data Service Option 32 > FCCH & SCH
Config > SCHO Enable = Off (or On); Test Data Service Option 32 > FCCH & SCH Config > SCH1 Enable = Off
(or On); Test Data Service Option 32 > FCCH & SCH Config > SCHO Config > Data Rate = 9.6 kbps; FCCH &
SCH Config > SCH1 Config > Data Rate = 9.6 kbps

BS Signal > RF Settings > RF Power > CDMA Power = -104 dBm/1.23MHz (RF > External attenuation IN/OUT
as per cable losses); RF Settings > RF Channel [BCO] = 384; RF Settings > RF Channel [BC1] = 325; BS
Signal > RF Settings > RF Power > PICH Level = -7dB; BS Signal > FCH > FCH Level =-7.4 dB

BS Signal > Power Control > Power Ctrl. Bits = All Up (Service Options 2,9 and 55)

BS Signal > Power Control > Power Ctrl. Bits = Hold (Service Options 32)

Cellular Band

Fundamental | Supplemental | Loopback | TestData | SCHn Result (dBm)
Channel Test Code Service Service
Mode Channel Test Option Option Ch. 1013 Ch. 384 Ch.777
Mode
1 N/A SO 2 N/A N/A 24.79 24.87 24.63
1 N/A SO 55 N/A N/A 24.71 24.75 24.56
2 N/A SO 9 N/A N/A 24.74 24.73 24.53
2 N/A SO 55 N/A N/A 24.70 24.75 24.55
N/A 3 N/A S0 32 OFF 24.80 24.85 24.53
N/A 3 N/A SO 32 ON 24.70 24.74 24.53

*SCH1 Enable — rejected by DUT

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement
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PCS Band
Fundamental | Supplemental | Loopback | TestData | SCHn Result (dBm)
Channel Test Code Service Service
Mode Channel Test Option Option Ch. 25 Ch. 600 Ch.1175
Mode
1 N/A SO 2 N/A N/A 23.21 22.89 22.75
1 N/A SO 55 N/A N/A 23.32 22.91 22.80
2 N/A SO 9 N/A N/A 23.35 22.90 22.75
2 N/A SO 55 N/A N/A 23.28 22.91 22.79
N/A 3 N/A SO 32 OFF 23.29 22.92 22.78
N/A 3 N/A SO 32 ON 23.29 22.91 22.75

Conducted Power Measurement 1xEvDo Revision 0: 850/1900 MHz

Configuration:

Network > Network Release = Release 0; Network > System ID = 2004; Access Probes > Initial Adjust (Probe
Initial Adjust) = 15 dBm; Probe Increment (Power Step) = 7.5 dB/step; Open Loop Adjust (BCO) = -81 dB (US
cellular); Open Loop Adjust (BC1) = -84 dB (N.American PCS)

AN Signal > Sector > Format = Manual; Sector ID = 00800580 00000000 00000000 00000000; RF Settings >
RF Power > 1xEv-Do Power = -105.5 dBm/1.23MHz (RF > External attenuation IN/OUT as per cable losses);
RF Settings > RF Channel [BCO] = 37; RF Settings > RF Channel [BC1] = 325; Power Control > Power control
bits = All Up

Layer > Application Layer > Test Applications > FTAP Cfg > DRC > ACK Ch Fixed Mode = Ack.Always;

DRC > Fixed Rate = 4 (307.2 kbps, 2-slots); Test Applications > RTAP Cfg > Data > Min. Rate = 5 (153.6
kbps); Data > Min. Rate = 5 (153.6 kbps)

Cellular Band

Release 0 Subtype Open Loop Adjust (BCO) Result (dBm)
Ch. 1013 Ch. 384 Ch.777
0 -81dB 24.87 24.89 24.72
PCS Band
Release 0 Subtype Open Loop Adjust (BCO) Result (dBm)
Ch. 25 Ch. 600 Ch.1175
0 -84 dB 23.46 23.11 22.94

Conducted Power Measurement 1xEvDo Revision A: 850/1900 MHz

Configuration:

Network > Network Release = Release A; Network > System ID = 2004; Access Probes > Initial Adjust (Probe
Initial Adjust) = 15 dBm; Probe Increment (Power Step) = 7.5 dB/step; Open Loop Adjust (BCO) = -81 dB (US
cellular); Open Loop Adjust (BC1) = -84 dB (N.American PCS)

AN Signal > Sector > Format = Manual; Sector ID = 00800580 00000000 00000000 00000000; RF Settings >
RF Power > 1xEv-Do Power = -60 dBm/1.23MHz (RF > External attenuation IN/OUT as per cable losses); RF
Settings > RF Channel [BCO] = 37; RF Settings > RF Channel [BC1] = 325; Power Control > Power control bits
= All Up

Subtype 0:

Layer > Protocol View Filter = Release 0 Settings; Layer > Application Layer > Test Applications > FTAP Cfg >
DRC > ACK Ch Fixed Mode = Ack.Always; DRC > Fixed Rate = 4 (307.2 kbps, 2-slots); Test Applications >
RTAP Cfg > Data > Min. Rate = 5 (153.6 kbps); Data > Max. Rate = 5 (153.6 kbps)

Subtype 2:

Layer > Protocol View Filter = Release A Settings; Layer > Application Layer > Test Applications > FTAP Cfg >
DRC > ACK Ch Fixed Mode = Ack.Always; DRC > Rate = 16 (307.2 kbps, 2-slots); Test Applications > RTAP
Cfg > Data > Min. Packet Size = 9 (4096 bits); Data > Max. Packet Size = 9 (4096 bits);

Cellular Band

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement
included in this document are traceable to Australian/national standards. NATA is a signatory to the ILAC
Mutual Recognition Arrangement for the mutual recognition of the equivalence of testing, calibration and
inspection reports.
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Release 0 Subtype Open Loop Adjust (BCO) Result (dBm)
Ch. 1013 Ch. 384 Ch.777
0 -81dB N/A* N/A* N/A*
2 -81dB 24.82 24.88 24.69
PCS Band
Release 0 Subtype Open Loop Adjust (BCO) Result (dBm)
Ch. 25 Ch. 600 Ch.1175
0 -84 dB N/A* N/A* N/A*
2 -84 dB 23.37 23.00 22.87

*DUT has no Subtype 0 capabilities

Frequency and Conducted Power Results GSM

Table 6
Coding GPRS Multislot Number of Uplink RF Channel Measured Power Calculated
Scheme Class Time-Slots Burst Average Power
(dBm) Frame Average
(100% Duty
Cycle)
(dBm)
Cs1 8 1 128 32.54 23.35
Cs1 8 1 190 33.72 24.53
Cs1 8 1 251 32.68 23.49
Cs1 10 2 128 32.96 26.78
Cs1 10 2 190 33.05 26.87
CS1 10 2 251 33.01 26.83
CSs1 11 3 128 N/A* N/A*
Cs1 11 3 190 N/A* N/A*
CS1 11 3 251 N/A* N/A*
Cs1 12 4 128 N/A* N/A*
Cs1 12 4 190 N/A* N/A*
Cs1 12 4 251 N/A* N/A*
Table 7
Coding GPRS Multislot Number of Uplink RF Channel Measured Power Calculated
Scheme Class Time-Slots Burst Average Power
(dBm) Frame Average
(100% Duty
Cycle)
(dBm)
MCS5 8 1 128 27.18 17.99
MCS5 8 1 190 27.10 17.91
MCS5 8 1 251 27.35 18.16
MCS5 10 2 128 27.44 21.26
MCS5 10 2 190 27.42 21.24
MCS5 10 2 251 27.43 21.25
MCS5 11 3 128 N/A* N/A*
MCS5 11 3 190 N/A* N/A*
MCS5 11 3 251 N/A* N/A*
MCS5 12 4 128 N/A* N/A*
MCS5 12 4 190 N/A* N/A*
MCS5 12 4 251 N/A* N/A*

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement
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Table 8
Coding GPRS Multislot Number of Uplink RF Channel Measured Power Calculated
Scheme Class Time-Slots Burst Average Power
(dBm) Frame Average
(100% Duty
Cycle)
(dBm)
Cs1 8 1 512 28.47 19.28
CS1 8 1 661 28.64 19.45
CSs1 8 1 810 28.63 19.44
Cs1 10 2 512 28.23 22.05
Cs1 10 2 661 28.70 22.52
CS1 10 2 810 28.85 22.67
CS1 11 3 512 N/A* N/A*
Cs1 11 3 661 N/A* N/A*
CS1 11 3 810 N/A* N/A*
Cs1 12 4 512 N/A* N/A*
CS1 12 4 661 N/A* N/A*
CS1 12 4 810 N/A* N/A*
Table 9
Coding GPRS Multislot Number of Uplink RF Channel Measured Power Calculated
Scheme Class Time-Slots Burst Average Power
(dBm) Frame Average
(100% Duty
Cycle)
(dBm)
MCS5 8 1 512 24.52 15.33
MCS5 8 1 661 24.51 15.32
MCS5 8 1 810 24.67 15.48
MCS5 10 2 512 24.57 18.39
MCS5 10 2 661 24.59 18.41
MCS5 10 2 810 24.71 18.53
MCS5 11 3 512 N/A* N/A*
MCS5 11 3 661 N/A* N/A*
MCS5 11 3 810 N/A* N/A*
MCS5 12 4 512 N/A* N/A*
MCS5 12 4 661 N/A* N/A*
MCS5 12 4 810 N/A* N/A*
*DUT has no GPRS/EGPRS Multislot Class 11 and 12 capabilities
Conducted Power Measurement UMTS 850 MHz
Configuration:
12.2 kbps RMC
Test Loop Mode 1
Bc =8, Bd = 15 (3GPP default)
TPC (Transmit Power Control) = All 1s
Table 10
Channel No. Bc Bd Result (dBm)
4132 8 15 24.01
4183 8 15 24.15
4233 8 15 24.08
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Conducted Power Measurement UMTS + HSDPA 850 MHz

Configuration:

Device HSDPA Category 6 (Downlink 3.6 Mbps and Uplink 384 kbps)

H-Set =1
QPSK in H-Set (1)

CQl Fidback Cycle = 4ms; CQl Repetition Rate = 2ms

Report No. M120917R_FCC_MC8355_SAR_GSM-UMTS
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Table 11
Sub Test No. Bc Bd | AAKN | ANAKN | ACQl Result (dBm) MPR
Ch 4132 Ch 4183 Ch 4233 (dB)
1 2 15 8 8 8 23.61 23.63 23.64 0.0
2 12 15 8 8 8 23.38 23.45 23.43 0.0
3 15 8 8 8 8 23.18 23.28 23.20 0.5
4 15 4 8 8 8 23.10 23.21 23.21 0.5

Conducted Power Measurement UMTS + HSDPA + HSUPA 850 MHz

Configuration:

Device HSUPA Release 6 (5.7 Mbps)
RMC 12.2 kbps + HSPA 34.108 with loop mode 1
HS-DPCCH, E-DPCCH, E-DPDCH Enabled

DPCH Channel Code {Bd (SF)} = 64
Power Control — TPC algorithm 2
3GPP default HS-DPCCH power offset parameters AAKN = 5; ANAKN = 5; Acaql = 2
E-TFCI table index = 0
E-DCH minimum set E-TFCI =9

PLnon-max = 0.84

Maximum Channelisation Code {fed (SF) and ped (codes)} — Subtests 1,2,4,5 = SF4; Subtest 3 = 2xSF4
Initial Serving Grant Value = Off

A HARQ =0

Number of Ref.E-TFClIs — Subtests 1,2,4,5 = 5; Subtest 3 =2
Set1 Patern Type = Closed Loop

Table 12
Sub [ Bc [ Bd A A A A Bed Bed AG Result (dBm) MPR
Test KN NAKN cal E-DPCCH (SF) (codes) | Index | 4132 4183 4233 (dB)
1 10 15 8 8 8 6 4 1 20 23.38 | 23.52 | 23.27 0.0
2 6 15 8 8 8 8 4 1 12 2159 | 21.83 | 21.54 2.0
3 15 9 8 8 8 8 4 2 15 2244 | 22.58 | 22.33 1.0
4 2 15 8 8 8 5 4 1 17 21.21 | 22.01 | 20.84 2.0
5 15 15 8 8 8 7 4 1 21 23.46 | 23.43 | 23.04 0.0
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Conducted Power Measurement UMTS 1700 MHz

Configuration:

12.2 kbps RMC

Test Loop Mode 1

Bc =8, Bd = 15 (3GPP default)

TPC (Transmit Power Control) = All 1s

Table 13
Channel No. Bc Bd Result (dBm)
1312 8 15 22.97
1427 8 15 22.98
1513 8 15 23.03

Conducted Power Measurement UMTS + HSDPA 1700 MHz

Configuration:

Device HSDPA Category 6 (Downlink 3.6 Mbps and Uplink 384 kbps)

H-Set =1

QPSK in H-Set (1)

CQl Fidback Cycle = 4ms; CQl Repetition Rate = 2ms

3GPP default HS-DPCCH power offset parameters AAKN = 5; ANAKN = 5; Acal =2

Table 14
Sub Test No. Bc Bd | AAKN | ANAKN | ACQI Result (dBm) MPR
1312 1427 1513 (dB)
1 2 15 8 8 8 22.47 22.53 22.63 0.0
2 12 15 8 8 8 22.16 22.20 22.31 0.0
3 15 8 8 8 8 21.96 22.01 22.06 0.5
4 15 4 8 8 8 21.95 22.03 22.09 0.5

Conducted Power Measurement UMTS + HSDPA + HSUPA 1700 MHz

Configuration:

Device HSUPA Release 6 (5.7 Mbps)

RMC 12.2 kbps + HSPA 34.108 with loop mode 1

HS-DPCCH, E-DPCCH, E-DPDCH Enabled

DPCH Channel Code {Bd (SF)} = 64

Power Control — TPC algorithm 2

3GPP default HS-DPCCH power offset parameters AAKN = 5; ANAKN = 5; Acaql = 2
E-TFCI table index = 0

E-DCH minimum set E-TFCIl =9

PLnon-max = 0.84

Maximum Channelisation Code {fed (SF) and Bed (codes)} — Subtests 1,2,4,5 = SF4; Subtest 3 = 2xSF4
Initial Serving Grant Value = Off

A HARQ =0

Number of Ref.E-TFCls — Subtests 1,2,4,5 = 5; Subtest 3 = 2

Set1 Patern Type = Closed Loop

Table 15
Sub | Bc | Bd A A A A Bed Bed AG Result (dBm) MPR
Test AKN NAKN | CQl | E-DPCCH (SF) | (codes) | Index | 1312 | 1427 | 1513 (dB)
1 10 | 15 8 8 8 6 4 1 20 22.20 | 22.23 | 22.08 0.0
2 6 15 8 8 8 8 4 1 12 20.58 | 20.40 | 20.50 2.0
3 15 9 8 8 8 8 4 2 15 21.39 | 21.29 | 21.07 1.0
4 2 15 8 8 8 5 4 1 17 20.48 | 20.83 | 20.90 2.0
5 15| 15 8 8 8 7 4 1 21 22,18 | 22.28 | 21.97 0.0
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Conducted Power Measurement UMTS 1900 MHz

Configuration:

12.2 kbps RMC

Test Loop Mode 1

Bc = 8, Bd = 15 (3GPP default)

TPC (Transmit Power Control) = All 1s

Table 16
Channel No. Bc Bd Result (dBm)
9262 8 15 23.43
9400 8 15 23.49
9538 8 15 23.23

Conducted Power Measurement UMTS + HSDPA 1900 MHz

Configuration:

Device HSDPA Category 6 (Downlink 3.6 Mbps and Uplink 384 kbps)

H-Set =1

QPSK in H-Set (1)

CQl Fidback Cycle = 4ms; CQI Repetition Rate = 2ms

3GPP default HS-DPCCH power offset parameters AAKN = 5; ANAKN = 5; AcQl =2

Table 17
Sub Test No. Bc Bd | AAKN | ANAKN | ACQl Result (dBm) MPR
9262 9400 9538 (dB)
1 2 15 8 8 8 22.94 22.93 22.71 0.0
2 12 15 8 8 8 22.50 22.46 22.36 0.0
3 15 8 8 8 8 22.44 22.48 22.37 0.5
4 15 4 8 8 8 22.45 22.50 22.31 0.5

Conducted Power Measurement UMTS + HSDPA + HSUPA 1900 MHz

Configuration:

Device HSUPA Release 6 (5.7 Mbps)

RMC 12.2 kbps + HSPA 34.108 with loop mode 1

HS-DPCCH, E-DPCCH, E-DPDCH Enabled

DPCH Channel Code {Bd (SF)} = 64

Power Control — TPC algorithm 2

3GPP default HS-DPCCH power offset parameters AAKN = 5; ANAKN = 5; Acaql = 2
E-TFCI table index = 0

E-DCH minimum set E-TFCI =9

PLnon-max = 0.84

Maximum Channelisation Code {fed (SF) and Bed (codes)} — Subtests 1,2,4,5 = SF4; Subtest 3 = 2xSF4
Initial Serving Grant Value = Off

A HARQ =0

Number of Ref.E-TFCls — Subtests 1,2,4,5 = 5; Subtest 3 = 2

Set1 Patern Type = Closed Loop

Table 18

Sub | Bc | Bd A A A A Bed Bed AG Result (dBm) MPR

Test AKN NAKN | CQl | E-DPCCH (SF) | (codes) | Index | 9262 | 9400 | 9538 (dB)
1 10 | 15 8 8 8 6 4 1 20 22.20 | 22.23 | 22.29 0.0
2 6 15 8 8 8 8 4 1 12 20.73 | 20.61 | 20.51 2.0
3 15 9 8 8 8 8 4 2 15 21.22 | 21.64 | 21.28 1.0
4 2 15 8 8 8 5 4 1 17 20.52 | 20.42 | 20.64 2.0
5 15| 15 8 8 8 7 4 1 21 22.21 | 22.09 | 22.03 0.0
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WWAN - FCC ID: EJE-MC8355D IC: 337J-MC8355D

Gobi3000 - IMEI — 357485040145726 -5dB Power Reduction
Conducted Power Measurement 1xEvDo Revision 0 850/1900 MHz

Configuration:
Network > Network Release = Release 0; Network > System ID = 2004; Access Probes > Initial Adjust (Probe

Initial Adjust) = 15 dBm; Probe Increment (Power Step) = 7.5 dB/step; Open Loop Adjust (BCO) = -81 dB (US
cellular); Open Loop Adjust (BC1) = -84 dB (N.American PCS)

AN Signal > Sector > Format = Manual; Sector ID = 00800580 00000000 00000000 00000000; RF Settings >
RF Power > 1xEv-Do Power = -105.5 dBm/1.23MHz (RF > External attenuation IN/OUT as per cable losses);
RF Settings > RF Channel [BCO] = 37; RF Settings > RF Channel [BC1] = 325; Power Control > Power control
bits = All Up

Layer > Application Layer > Test Applications > FTAP Cfg > DRC > ACK Ch Fixed Mode = Ack.Always;

DRC > Fixed Rate = 4 (307.2 kbps, 2-slots); Test Applications > RTAP Cfg > Data > Min. Rate =5 (153.6
kbps); Data > Min. Rate = 5 (153.6 kbps)

Cellular Band

Release 0 Subtype Open Loop Adjust (BCO) Result (dBm)
Ch. 1013 Ch. 384 Ch.777
0 -81dB 19.81 19.89 19.77
PCS Band
Release 0 Subtype Open Loop Adjust (BCO) Result (dBm)
Ch. 25 Ch. 600 Ch.1175
0 -84 dB 18.18 18.11 18.05

Table: Frequency and Conducted Power Results GSM

Table 19
Coding Scheme GPRS Multislot RF Channel Measured Power Calculated Power
Class Burst Average Frame Average
(dBm) (100% Duty Cycle)
(dBm)
Cs1 10 128 28.54 22.36
Cs1 10 190 28.35 22.17
CS1 10 251 28.49 22.31
Cs1 11 128 N/A* N/A*
Cs1 11 190 N/A* N/A*
CS1 11 251 N/A* N/A*
CSs1 12 128 N/A* N/A*
Cs1 12 190 N/A* N/A*
CS1 12 251 N/A* N/A*
Table 20
Coding Scheme GPRS Multislot RF Channel Measured Power Calculated Power
Class Burst Average Frame Average
(dBm) (100% Duty Cycle)
(dBm)
CS1 10 512 23.83 17.65
Cs1 10 661 23.75 17.57
CS1 10 810 23.59 17.41
Cs1 11 512 N/A* N/A*
Cs1 11 661 N/A* N/A*
CS1 11 810 N/A* N/A*
CSs1 12 512 N/A* N/A*
CSs1 12 661 N/A* N/A*
CS1 12 810 N/A* N/A*

*DUT has no GPRS/EGPRS Multislot Class 11 and 12 capabilities

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement
included in this document are traceable to Australian/national standards. NATA is a signatory to the ILAC
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Conducted Power Measurement UMTS 850 MHz

Configuration:

12.2 kbps RMC

Test Loop Mode 1

Bc = 8, Bd = 15 (3GPP default)

TPC (Transmit Power Control) = All 1s

Table 21
Channel No. Bc Bd Result (dBm)
4132 8 15 20.11
4183 8 15 20.36
4233 8 15 20.25
Conducted Power Measurement UMTS 1700 MHz
Configuration:
12.2 kbps RMC
Test Loop Mode 1
Bc = 8, Bd = 15 (3GPP default)
TPC (Transmit Power Control) = All 1s
Table 22
Channel No. Bc Bd Result (dBm)
1312 8 15 18.24
1427 8 15 18.22
1513 8 15 18.37
Conducted Power Measurement UMTS 1900 MHz
Configuration:
12.2 kbps RMC
Test Loop Mode 1
Bc =8, Bd = 15 (3GPP default)
TPC (Transmit Power Control) = All 1s
Table 23
Channel No. Bc Bd Result (dBm)
9262 8 15 18.21
9400 8 15 18.53
9538 8 15 18.52

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement
included in this document are traceable to Australian/national standards. NATA is a signatory to the ILAC
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4.1 Battery Status

The DUT battery was fully charged prior to commencement of measurement. Each SAR test was completed
within 30 minutes. The battery condition was monitored by measuring the RF field at a defined position inside
the phantom before the commencement of each test and again after the completion of the test. It was not
possible to perform conducted power measurements at the output of the DUT, at the beginning and end of
each scan due to lack of a suitable antenna port. The uncertainty associated with the power drift was less than
5% and was assessed in the uncertainty budget.

5.0 DETAILS OF TEST LABORATORY

5.1 Location

EMC Technologies Pty Ltd

176 Harrick Road

Keilor Park, (Melbourne) Victoria
Australia 3042

Telephone: +61 3 9365 1000
Facsimile: +61 3 9331 7455
email: melb@emctech.com.au
website: www.emctech.com.au

5.2 Accreditations
EMC Technologies Pty. Ltd. is accredited by the National Association of Testing Authorities, Australia (NATA).
NATA Accredited Laboratory Number: 5292

EMC Technologies Pty Ltd is NATA accredited for the following standards:

Table 24

ASINZS 2772.2: RF and microwave radiation hazard measurement

ACMA: Radio communications (Electromagnetic Radiation - Human Exposure) Standard 2003

FCC: Guidelines for Human Exposure to RF Electromagnetic Field OET65C 01/01

EN 50360: 2001 Product standard to demonstrate the compliance of mobile phones with the basic
restrictions related to human exposure to electromagnetic fields (300 MHz — 3 GHz)

EN 62209-1: 2006 Human Exposure to radio frequency fields from hand-held and body-mounted wireless

communication devices - Human models instrumentation and procedures.
Part 1: Procedure to determine the specific absorption rate (SAR) for hand-held devices
used in close proximity to the ear (300 MHz to 3 GHz)

EN 62209-2:2010 Human Exposure to radio frequency fields from hand-held and body-mounted wireless
communication devices - Human models instrumentation and procedures
Part 2: Procedure to determine the specific absorption rate (SAR) for wireless
communication devices used in close proximity to the human body (frequency range of 30
MHz to 6 GHz

IEEE 1528: 2003 Recommended Practice for Determining the Peak Spatial-Average Specific Absorption
Rate (SAR) in the Human Head Due to Wireless Communications Devices: Measurement
Techniques.

Refer to NATA website www.nata.asn.au for the full scope of accreditation.

5.3 Environmental Factors

The measurements were performed in a shielded room with no background RF signals. The temperature in the
laboratory was controlled to within 21+1°C, the humidity was in the range 36% to 51%. The liquid parameters
are measured daily prior to the commencement of each test. Tests were performed to check that reflections
within the environment did not influence the SAR measurements. The noise floor of the DASY5 SAR
measurement system using the SN1380 probe was less than 5uV in both air and liquid mediums.

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement
\ included in this document are traceable to Australian/national standards. NATA is a signatory to the ILAC
MNATA Mutual Recognition Arrangement for the mutual recognition of the equivalence of testing, calibration and
g inspection reports.
Mecraaten Ho. 828 This document shall not be reproduced except in full.




WWAN - FCC ID: EJE-MC8355D IC: 337J-MC8355D  Report No. M120917R_FCC_MC8355_SAR_GSM-UMTS Page 20 of 232

6.0 DESCRIPTION OF SAR MEASUREMENT SYSTEM

Table 25
Applicable Head Configurations : None
Applicable Body Configurations : Lap Held Position
: Edge On Position

6.1 Probe Positioning System

The measurements were performed with the state-of-the-art automated near-field scanning system DASY5
Version 52 from Schmid & Partner Engineering AG (SPEAG). The DASY5 fully complies with the OET65 C
(01-01), IEEE 1528 and EN62209-1 and EN62209-2 SAR measurement requirements.

6.2 E-Field Probe Type and Performance

The SAR measurements were conducted with SPEAG dosimetric probe ET3DV6 Serial: 1380. Please refer to
appendix C for detailed information.

6.3 Validation

6.3.1 Validation Results (900 MHz and 1800 MHz and 1950 MHz)

The following tables lists the dielectric properties of the tissue simulating liquid measured prior to SAR
validation. The results of the validation are listed in columns 4 and 5. The forward power into the reference

dipole for SAR validation was adjusted to 250 mW.

Table: Validation Results

Table 26
e \/Daallit(éaéion 2. er 3.6 (mho/m) | 4. Measured 5. Measured
Frequency (measured) | (measured) | SAR 1g (mW/g) | SAR 10g (mW/g)
3?9(?3((:;. 2012 52 3 158 10.3 5.34
5‘:8(())%t.|\§|3;2 523 1.59 9.83 5.27
ooty | 5 105 289 e
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6.3.2 Deviation from reference validation values

The SPEAG calibration reference SAR value is the SAR validation result obtained in a specific dielectric liquid
using the validation dipole during calibration. The measured one-gram SAR should be within 10% of the
expected target reference values shown in table below.

Table: Deviation from reference validation values @ (900MHz, 1800 MHz and 1950 MHz)

Table 27
Frequency Measured | Measured SPEAG Deviation
and Date SAR 1g SAR 1g Calibration From
(mWi/g) (Normalized | reference SPEAG
to 1W) SAR Value Reference
1g (mW/g) 1g (%)
5" Oct, 2012
oo 2.87 11.48 11.1 3.42
th
8 gggtMﬁogz 2.90 11.60 11.1 450
th
9 QESVMZHTz 2.89 11.56 11.1 4.14
th
5 1;2%',\/?'3;2 9.83 39.32 38.7 1.60
ih
7 1 g‘o"o"mzlf";z 9.70 38.80 387 0.26
rd
3 19%?',;'3;2 10.3 4120 38.8 6.19
th
41905?"&'312 10.0 40.00 38.8 3.09
th
8 1315%Viv|2|3212 9.96 39.84 38.8 2.68

NOTE: All reference validation values are referenced to 1W input power.

6.3.3 Liquid Depth 15cm

During the SAR measurement process the liquid level was maintained to a level of 15cm with a
tolerance of 0.5cm.

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement
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Photo of liquid Depth in Flat Phantom

6.4 Phantom Properties

The phantoms used during the testing comply with the OET65 C (01-01), IEEE 1528 and EN62209-1 and

EN62209-2 SAR measurement requirements.

Page 22 of 232

Phantom Properties

Required

Measured

Thickness of flat section

2.0mm + 0.2mm (bottom section)

2.12-2.20mm

Dielectric Constant

<5.0

4.603 @ 300MHz (worst-case frequency)

Loss Tangent

<0.05

0.0379 @ 2500MHz (worst-case frequency)

6.5 Tissue Material Properties

The dielectric parameters of the human tissue simulating liquid were measured prior to SAR assessment using

the HP85070A dielectric probe kit, HP8753ES and HP8714B Network Analyser.
parameters are shown in the following table.

Table: Measured Body Simulating Liquid Dielectric Values for Validations

The actual dielectric

Table 28
Frequency er er o (mho/m) c p
Band (measured (target) (measured (target) kg/m?®
range) range)
900 MHz 55.0 +5% 1.05 5%
Body 52.4 - 531 (52.3 to 57.8) 1.04-1.05 (1.00 to 1.10) 1000
1800 MHz 53.3 +5% 1.52 +5%
Body 52.0-52.3 (50.6 to 56.0) 1.56-1.59 (1.44 to 1.60) 1000
1950 MHz 53.3 +5% 1.52 +5%
Body 51.0-52.3 (50.6 to 56.0) 1.57-1.59 (1.44 to 1.60) 1000
NOTE: The Body liquid parameters were within the required tolerances of +5%.
Table: Measured Body Simulating Liquid Dielectric Values at 850MHz
Table 29
r o (mho/m)
Frequency N er c P
Band (T 2EEL RS (target) (T 2EEL RS (target) kg/m?®
range) range)
825 MHz 55.2 +5% 0.97 +5%
Body 53.0-53.9 (52.4 to 58.0) 0.96 -0.98 (0.92 to 1.02) 1000
835 MHz 55.2 +5% 0.97 +5%
Body 53.0-53.8 (52.4 to 58.0) 0.98 (0.92 to 1.02) 1000
850 MHz 55.2 +5% 0.97 +5%
Body 528-536 (52.4 to 58.0) 0.99 (0.92 t0 1.02) 1000

Note: The body liquid parameters were within the required tolerances of +5%.
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Table: Measured Body Simulating Liquid Dielectric Values at 1880MHz
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Table 30
r o (mho/m)
Frequency < er (o] p
Band (measured (target) (measured (target) kg/m®
range) range)
1850 MHz 53.3 +5% 1.52 +5%
Body 51.4-52.7 (50.6 to 56.0) 1.52-1.53 (1.44 to 1.60) 1000
1880.0 MHz 53.3 +5% 1.52 +5%
Body 51.3-526 (50.6 to 56.0) 1.54-1.55 (1.44 to 1.60) 1000
1910 MHz 53.3 +5% 1.52 5%
Body 512-525 (50.6 to 56.0) 1.56 - 1.57 (1.44 to 1.60) 1000
Note: The body liquid parameters were within the required tolerances of +5%.
Table: Measured Body Simulating Liquid Dielectric Values at 1735MHz
Table 31
r o (mho/m)
Frequency € er c p
Band (2L ES (target) (2L Ee (target) kg/m?®
range) range)
1712 MHz 53.3 +5% 1.52 +5%
Body 524-526 (50.6 to 56.0) 1.49-1.52 (1.44 to 1.60) 1000
1735 MHz 53.3 +5% 1.52 +5%
Body 523-525 (50.6 to 56.0) 1.51-1.54 (1.44 to 1.60) 1000
1750 MHz 53.3 +5% 1.52 +5%
Body 52.2-525 (50.6 to 56.0) 1.52-1.56 (1.44 to 1.60) 1000

Note: The body liquid parameters were within the required tolerances of +5%.

6.5.1

Liquid Temperature and Humidity
The humidity and dielectric/ambient temperatures were recorded during the assessment of the tissue material

dielectric parameters. The difference between the ambient temperature of the liquid during the dielectric
measurement and the temperature during tests was less than |2|°C.

Table: Temperature and Humidity recorded for each day

Table 32
Date Ambient Liquid Humidity (%)
Temperature (°C) | Temperature (°C)
3 Oct. 2012 21.1 20.9 42
4" Oct. 2012 20.5 20.3 41
5" Oct. 2012 20.4 20.1 42
8" Oct. 2012 20.8 20.5 36
7" Nov. 2012 20.3 20.0 39
8" Nov. 2012 20.5 20.1 49
9" Nov. 2012 20.2 19.8 51
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6.6 Simulated Tissue Composition Used for SAR Test

The tissue simulating liquids are created prior to the SAR evaluation and often require slight modification each
day to obtain the correct dielectric parameters.

Tissue Type: Body @ 850/900MHz

Volume of Liquid: 30 Litres

Tissue Type: Body @ 1800/1950MHz MHz

Report No. M120917R_FCC_MC8355_SAR_GSM-UMTS

Volume of Liquid: 30 Litres
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Table 33

Approximate % By Weight Approximate % By Weight
Composition Composition

Distilled Water 56 Distilled Water 404

Salt 0.76 Salt 0.5

Sugar 41.76 Sugar 58

HEC 1.21 HEC 1

Bactericide 0.27 Bactericide 0.1

*Refer “OET Bulletin 65 97/01 P38”

6.7 Device Holder for Laptops and P 10.1 Phantom
A low loss clamp was used to position the DUT underneath the phantom surface.

Refer to Appendix A for photographs of device positioning

7 SAR MEASUREMENT PROCEDURE USING DASY5
The SAR evaluation was performed with the SPEAG DASY5 system. A summary of the procedure follows:

a) A measurement of the SAR value at a fixed location is used as a reference value for assessing the
power drop of the DUT. The SAR at this point is measured at the start of the test, and then again at the
end of the test.

b) The SAR distribution at the exposed flat section of the flat phantom is measured at a distance of 4 mm
from the inner surface of the shell. The area covers the entire dimension of the DUT and the horizontal
grid spacing is 15 mm x 15 mm. The actual Area Scan has dimensions of 90 mm x 150 mm
surrounding the test device. Based on this data, the area of the maximum absorption is determined by
Spline interpolation.

c) Around this point, a volume of 30 mm x 30 mm x 30 mm is assessed by measuring 7 x 7 x 7 points. On
the basis of this data set, the spatial peak SAR value is evaluated with the following procedure:

(i) The data at the surface are extrapolated, since the centre of the dipoles is 2.7 mm away from the
tip of the probe and the distance between the surface and the lowest measuring point is 4 mm.
The extrapolation is based on a least square algorithm. A polynomial of the fourth order is
calculated through the points in z-axes. This polynomial is then used to evaluate the points
between the surface and the probe tip.

(i) The maximum interpolated value is searched with a straightforward algorithm. Around this
maximum the SAR values averaged over the spatial volumes (1 g and 10 g) are computed using
the 3D-Spline interpolation algorithm. The 3D-Spline is composed of three one-dimensional
splines with the “Not a knot”- condition (in x, y and z-direction). The volume is integrated with the
trapezoidal — algorithm. One thousand points (10 x 10 x 10) are interpolated to calculate the
averages.

(iii) All neighbouring volumes are evaluated until no neighbouring volume with a higher average value
is found.

(iv) The SAR value at the same location as in Step (a) is again measured to evaluate the actual power
drift.

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement
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8 MEASUREMENT UNCERTAINTY
The uncertainty analysis is based on the template listed in the IEEE Std 1528-2003 for both Handset SAR tests

and Validation uncertainty. The measurement uncertainty of a specific device is evaluated independently and
the total uncertainty for both evaluations (95% confidence level) must be less than 30%.

Table 34: Uncertainty Budget for DASY5 Version 52 — DUT SAR

Error Description Li/naﬁﬁg' FE;Z? Div. Ci(19) ( 1%ig) 19 ui 10g ui Vi
Measurement System
Probe Calibration 6 N 1.00 1 1 6.00 6.00 o0
Axial Isotropy 47 R 1.73 0.7 0.7 1.90 1.90 ©
Hemispherical Isotropy 9.6 R 1.73 0.7 0.7 3.88 3.88 0
Boundary Effects 1 R 1.73 1 1 0.58 0.58 o
Linearity 47 R 1.73 1 1 2.71 2.71 ©
System Detection Limits 1 R 1.73 1 1 0.58 0.58 0
Readout Electronics 0.3 N 1.00 1 1 0.30 0.30 o0
Response Time 0.8 R 1.73 1 1 0.46 0.46 ©
Integration Time 2.6 R 1.73 1 1 1.50 1.50 0
RF Ambient Noise R 1.73 1 1 1.73 1.73 o
RF Ambient Reflections R 1.73 1 1 1.73 1.73 o
Probe Positioner 04 R 1.73 1 1 0.23 0.23 0
Probe Positioning 29 R 1.73 1 1 1.67 1.67 0
Max. SAR Eval. 1 R 1.73 1 1 0.58 0.58 o0
Post Processing 2 R 1.73 1 1 1.15 1.15 o
Test Sample Related
Power Scaling 0 R 1.73 1 1 0.00 0.00 ©
Test Sample Positioning 29 N 1.00 1 1 2.90 2.90 145
Device Holder Uncertainty 3.6 N 1.00 1 1 3.60 3.60 5
al;;p:utr:rc:]\gﬁ; Variation — SAR Drift 447 R 173 1 1 258 258 w
Phantom and Setup
Phantom Uncertainty 75 R 1.73 1 1 4.33 4.33 0
\l;Ia(?Lljj(leds Conductivity — Deviation from target 5 R 173 0.64 0.43 185 124 -
\I;;(?:Lds Permittivity — Deviation from target 5 R 173 06 0.49 173 141 -
tir?:eicrjt;rc])tr;ductivity — Measurement 25 N 100 0.64 0.71 160 178 w
tir?éjégt;ﬁtr;nittivity - Measurement 25 N 100 06 0.26 150 0.65 w
Temp.unc. - Conductivity 1.7 R 1.73 0.78 0.71 0.77 0.70 o
Temp. unc. - Permittivity 0.3 R 1.73 0.23 0.26 0.04 0.05 o
Combined standard Uncertainty (uc) 116 | 114

H 0,

Eé{)/%nl-d)ed Uncertainty (95% CONFIDENCE k= 2 232 | 228

Estimated total measurement uncertainty for the DASY5 measurement system was £11.6%. The extended
uncertainty (K = 2) was assessed to be +23.2% based on 95% confidence level. The uncertainty is not added
to the measurement result.
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Table 35: Uncertainty Budget for DASY5 Version 52 — Validation

Error Description LU:E:' Fg;? Div. | Ci(19) (1%9) 1g ui 109 ui Vi
Measurement System
Probe Calibration 6 N 1.00 1 1 6.00 6.00 o0
Axial Isotropy 47 R 1.73 1 1 2.71 2.71 0
Hemispherical Isotropy 9.6 R 1.73 0 0 0.00 0.00 0
Boundary Effects 1 R 1.73 1 1 0.58 0.58 o0
Linearity 47 R 1.73 1 1 2.71 2.71 0
System Detection Limits 1 R 1.73 1 1 0.58 0.58 0
Readout Electronics 0.3 N 1.00 1 1 0.30 0.30 0
Response Time 0 R 1.73 1 1 0.00 0.00 0
Integration Time 0 R 1.73 1 1 0.00 0.00 0
RF Ambient Noise 1 R 1.73 1 1 0.58 0.58 0
RF Ambient Reflections 1 R 1.73 1 1 0.58 0.58 0
Probe Positioner 0.8 R 1.73 1 1 0.46 0.46 0
Probe Positioning 6.7 R 1.73 1 1 3.87 3.87 o0
Max. SAR Eval. R 1.73 1 1 1.15 1.15 0
Post Processing R 1.73 1 1 1.15 1.15 0
Dipole Related
Deviation of exp. dipole 55 R 1.73 1 1 3.18 3.18 0
Dipole Axis to Liquid Dist. 2 R 1.73 1 1 1.15 1.15 ©
Input power & SAR drift 3.40 R 1.73 1 1 1.96 1.96 0
Phantom and Setup
Phantom Uncertainty 4 R 1.73 1 1 2.31 2.31 o0
\l;la(?Lljj(lads Conductivity — Deviation from target 5 R 173 0.64 043 185 124 w
\I;;(?ltjlgjs Permittivity — Deviation from target 5 R 173 06 0.49 173 141 -
oy~ Measuremen 25 | N [ 100 | o078 | o071 | 195 | 178 | =
Liquid Permittivity — Measurement uncertainty 25 N 1.00 0.26 0.26 0.65 0.65 0
Temp.unc. - Conductivity 1.7 R 1.73 0.78 0.71 0.77 0.70 0
Temp. unc. - Permittivity 0.3 R 1.73 0.23 0.26 0.04 0.05 0
Combined standard Uncertainty (uc) 10.1 9.9
Eé;\)/aEnljed Uncertainty (95% CONFIDENCE k= 2 20.2 198

Estimated total measurement uncertainty for the DASY5 measurement system was +10.1%. The extended
uncertainty (K = 2) was assessed to be +20.2% based on 95% confidence level. The uncertainty is not added
to the Validation measurement result.
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9 EQUIPMENT LIST AND CALIBRATION DETAILS

Table 36: SPEAG DASY5 Version 52

Report No. M120917R_FCC_MC8355_SAR_GSM-UMTS
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Equipment Type Manufacturer NMu?ndbe(l,r Serial Number CaIiDbLeétion tﬁissegei?;
Robot - Six Axes Staubli RX90BL N/A Not applicable 4
Robot Remote Control SPEAG CS7MB RX90B Not applicable 4
SAM Phantom SPEAG N/A 1260 Not applicable

SAM Phantom SPEAG N/A 1060 Not applicable

Flat Phantom AndreT 101 P 10.1 Not Applicable v
Flat Phantom AndreT 9.1 P 9.1 Not Applicable v
Flat Phantom SPEAG ELI 4.0 1101 Not Applicable

Data Acquisition Electronics SPEAG DAE3 V1 359 21-June-2013

Data Acquisition Electronics SPEAG DAE3 V1 442 05-Dec-2012 v
Probe E-Field - Dummy SPEAG DP1 N/A Not applicable

Probe E-Field SPEAG ET3DV6 1380 12-Dec-2012 v
Probe E-Field SPEAG ET3DV6 1377 20-June-2013

Probe E-Field SPEAG ES3DV6 3029 Not Used

Probe E-Field SPEAG EX3DV4 3563 21-June-2013

Probe E-Field SPEAG EX3DV4 3657 14-Dec-2012

Antenna Dipole 300 MHz SPEAG D300V3 1012 30-Nov-2012

Antenna Dipole 450 MHz SPEAG D450V3 1074 30-Nov-2012

Antenna Dipole 750 MHz SPEAG D750V2 1051 9-Jan-2014

Antenna Dipole 900 MHz SPEAG D900V2 047 22-June-2014 v
Antenna Dipole 1640 MHz SPEAG D1640V2 314 20-June-2014

Antenna Dipole 1800 MHz SPEAG D1800V2 242 20-June-2014 v
Antenna Dipole 1950 MHz SPEAG D1950V3 1113 10-Dec -2012 v
Antenna Dipole 2450 MHz SPEAG D2450V2 724 09-Dec-2012

Antenna Dipole 2600 MHz SPEAG D2600V2 1044 10-Jan-2014

Antenna Dipole 3500 MHz SPEAG D3500V2 1002 13-July-2013

Antenna Dipole 5600 MHz SPEAG D5GHzV2 1008 14-Dec-2013

RF Amplifier EIN 603L N/A *In test

RF Amplifier Mini-Circuits ZHL-42 N/A *In test 4
RF Amplifier Mini-Circuits ZVE-8G N/A *In test

Synthesized signal generator Hewlett Packard ESG-D3000A GB37420238 *In test v
RF Power Meter Hewlett Packard 437B 3125012786 30-Aug-2013 v
RF Power Sensor 0.01 - 18 GHz Hewlett Packard 8481H 1545A01634 03-Sept-2013 v
RF Power Meter Rohde & Schwarz NRP 101415 17-Sept-2013

RF Power Sensor Rohde & Schwarz NRP - Z81 100174 17-Sept-2013

RF Power Meter Dual Hewlett Packard 435A 1733A05847 *In test v
RF Power Sensor Hewlett Packard 8482A 2349A10114 *In test v
Network Analyser Hewlett Packard 8714B GB3510035 27-Sept-2013 v
Network Analyser Hewlett Packard 8753ES JP39240130 5-Nov-2013 v
Dual Directional Coupler Hewlett Packard 778D 1144 04700 *In test

Dual Directional Coupler NARDA 3022 75453 *In test 4
Radio Communication Test Set Rohde & Schwarz CMU200 101573 Not Applicable 4
Radio Communication Test Set Anritsu MT8820A 6200240559 Not Applicable

Radio Communication Test Set Agilent PXT E6621A MY51100168 Not Applicable

* Calibrated during the test for the relevant parameters.

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement
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10 TEST METHODOLOGY

Notebooks should be evaluated in normal use positions, typical for lap-held bottom-face only. However the
number of positions will depend on the number of configurations the tablet can be operated in. The “STYLISTIC
Q SERIES” PC can be used on the lap (see Appendix A) or hand held as a Tablet PC.

10.5.1 “Lap Held” Position Definition (Omm spacing)

The DUT was tested in the 2.00 mm flat section of the AndreT Flat phantom for the “Lap Held” position. The
Transceiver was placed at the bottom of the phantom and suspended in such way that the back of the DUT
was touching the phantom. This device orientation simulates the PC’s normal use — being held on the lap of the
user.

10.5.2 “Edge On” Position

The DUT was tested in the (2.00 mm) flat section of the AndreT Flat phantom for the “Edge On” position. The
Antenna edge of the Transceiver was placed underneath the flat section of the phantom and suspended until
the edge touched the phantom. Refer to Appendix A for photos of measurement positions.

10.6  List of All Test Cases (Antenna In/Out, Test Frequencies, User Modes)

The DUT has a fixed antenna. Depending on the measured SAR level up to three test channels with the test
sample operating at maximum power were recorded. The following table represents the matrix used to
determine what testing was required. All relevant provisions of KDB 447498 and KDB 941225 are applied for
SAR measurements of the host system. Due to the screen size <12 inches, KDB 616217 was not used in the
SAR evaluation instead “Supplement to the KDB 616217” was followed.

Table: Testing configurations

Table 37

Phantom Device Mode Test Configurations

Configuration WWAN Band Channel Channel Channel
Name (Low) (Middle) (High)

Lap Held GPRS 850 MHz X

GPRS 1900 MHz
Ev-Do 850 MHz
Ev-Do 1900 MHz
WCDMA 850 MHz
WCDMA 1735 MHz
WCDMA 1900 MHz
Edge On GPRS 850 MHz
GPRS 1900 MHz
Ev-Do 850 MHz
Ev-Do 1900 MHz
WCDMA 850 MHz
WCDMA 1735 MHz
WCDMA 1900 MHz

DX | XXX XXX [X[X [X [X [X X

Legend
X | Testing Required in this configuration

Testing required in this configuration only if SAR of middle channel is more than 3dB
below the SAR limit or it is the worst case.
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11 SAR MEASUREMENT RESULTS

The SAR values averaged over 1g tissue masses were determined for the sample DUT for all test
configurations listed in section 10.2.

11.5 SAR Results

There are three modes of operation which include UMTS, GPRS and Ev-Do transmission. Table below displays
the SAR results.

Table: SAR MEASUREMENT RESULTS - 850MHz GPRS

Table 38
Test Plot | Test Test Number | Measured Measured 1g | Measure
Position No. Channel Freq of Time | Burst avr. SAR Results d Drift
(MHz) Slots power (mWI/g) (dB)
(dBm)
L 1 128 824 2 28.54 1.32 0.00
ap Held Omm 2 190 836 2 28.35 113 0.02
Spacing DPC ON
3 251 849 2 28.49 0.962 -0.01
Lap Held 5 4 128 824 2 32.96 1.21 -0.02
S‘;zcifg oPG OFF |5 190 836 2 33.05 1.01 -0.16
6 251 849 2 33.01 0.887 0.03
, 7 128 824 2 32.96 0.149 0.02
mdge# 2 Primary g 190 836 2 33.05 0.145 0.02
9 251 849 2 33.01 0.140 -0.00

NOTE: The measurement uncertainty of 23.2% was not added to the result.

The highest SAR level recorded was 1.32 m\W/g as evaluated in a 1g cube of averaging mass. This value was
obtained in Lap Held Omm Spacing position with DPC ON in GPRS mode, utilizing channel 128 (824 MHz).

Table: SAR MEASUREMENT RESULTS — 1900MHz GPRS

Table 39
Test Plot | Test Test Number | Measured Measured 1g | Measure
Position No. Channel Freq of Time | Burst avr. SAR Results d Drift
(MHz) Slots power (mWI/g) (dB)
(dBm)
Lap Held 0 10 512 1850.2 2 23.83 1.23 -0.14
ap riela umm 11 661 1880 2 23.75 1.01 0.00
Spacing DPC ON
12 810 1909.8 2 23.59 0.782 0.02
Lap Held 5 13 512 1850.2 2 28.23 0.954 -0.02
ap rield omm 14 661 1880 2 28.70 0.677 0.06
Spacing DPC OFF
15 810 1909.8 2 28.85 0.517 -0.01
Edge # 2 - Pri 16 512 1850.2 2 28.23 0.617 -0.06
O et 17 661 1880 2 28.70 0.469 0.03
18 810 1909.8 2 28.85 0.376 -0.05

NOTE: The measurement uncertainty of 23.2% was not added to the result.

The highest SAR level recorded was 1.23 mW/g as evaluated in a 1g cube of averaging mass. This value was
obtained in Lap Held Omm Spacing position with DPC ON in GPRS mode, utilizing channel 512 (1850.2 MHz).
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Table: SAR MEASUREMENT RESULTS — 850MHz UMTS

Table 40
Test Plot | Test Test Freq | Measured Measured 1g | Measured Drift
Position No. Channel | (MHz) average SAR Results (dB)
power (dBm) | (mW/g)
Lap Held 0 19 4132 826.4 20.11 0.827 0.02
S‘;‘)gcifg D;“CmON 20 4183 836.6 20.36 0.664 -0.07
21 4233 846.6 20.25 0.707 0.12
Lap Held 5 22 4132 826.4 24.01 0.788 0.11
S‘;zcifg oPG OFF |23 4183 836.6 2415 0.661 0.09
24 4233 846.6 24.08 0.775 -0.01
Edge # 2 - Pri 25 4132 826.4 24.01 0.112 0.06
O et 26 4183 836.6 2415 0.102 0.00
27 4233 846.6 24.08 0.133 -0.08

NOTE: The measurement uncertainty of 23.2% was not added to the result.

The highest SAR level recorded was 0.827 mW/g as evaluated in a 1g cube of averaging mass. This value was
obtained in Lap Held Omm Spacing position with DPC ON in UMTS mode, utilizing channel 4132 (826.4 MHz).

Table: SAR MEASUREMENT RESULTS — 1735MHz UMTS

Table 41
Test Plot | Test Test Freq | Measured Measured 1g | Measured Drift
Position No. Channel | (MHz) average SAR Results (dB)
power (dBm) | (mW/g)
L 28 1312 1712.4 18.24 1.40 0.11
ap Held Omm 20 | 1427 1735.4 18.22 158 20.10
Spacing DPC ON
30 1513 1752.6 18.37 1.58 -0.16
31 1312 1712.4 22.97 1.35 -0.16
ézzgr?éd;;ncmow 32 | 1427 1735.4 22.98 136 011
33 1513 1752.6 23.03 1.40 -0.04
Edge # 2 - Pri 34 1312 1712.4 22.97 0.254 -0.06
O et [ 35 1427 1735.4 22.98 0.155 0.04
36 1513 1752.6 23.03 0.366 0.00

NOTE: The measurement uncertainty of 23.2% was not added to the result.

The highest SAR level recorded was 1.58 mW/g as evaluated in a 1g cube of averaging mass. This value was
obtained in Lap Held Omm Spacing position with DPC ON in UMTS mode, utilizing channel 1427 (1735.4 MHz).
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Table: SAR MEASUREMENT RESULTS - 1900MHz UMTS

Table 42
Test Plot | Test Test Freq | Measured Measured 1g | Measured Drift
Position No. Channel | (MHz) average SAR Results (dB)
power (dBm) | (mW/g)
Lap Held 0 37 9262 1852.4 18.21 1.12 0.15
S";zcifg opeoN |38 9400 1880 18.53 123 o011
39 9538 1907.6 18.52 1.21 -0.07
Lap Held 5 40 9262 1852.4 23.43 1.03 0.15
Sf)‘;cir?g oPeOFE |41 9400 1880 23.49 T18 0.00
42 9538 1907.6 23.23 0.895 -0.11
Edge # 2 - Pri 43 9262 1852.4 23.43 0.748 0.04
O et |44 9400 1880 2349 0.892 0.02
45 9538 1907.6 23.23 0.698 -0.03

NOTE: The measurement uncertainty of 23.2% was not added to the result.

The highest SAR level recorded was 1.43 mW/g as evaluated in a 1g cube of averaging mass. This value was
obtained in Lap Held Omm Spacing position with DPC ON in UMTS mode, utilizing channel 9400 (1880 MHz).

Table: SAR MEASUREMENT RESULTS - 850MHz Ev-Do Rev.0

Table 43
Test Plot | Test Test Freq | Measured Measured 1g | Measured Drift
Position No. Channel | (MHz) average SAR Results (dB)
power (dBm) | (mW/g)
Lap Held 0 46 1013 824.7 19.81 0.790 -0.19
S?)zcifg DF'[“C"‘ON 47 0384 836.52 19.89 0.616 -0.09
48 0777 848.31 19.77 0.545 -0.03
Lap Held 5 49 1013 824.7 24.87 0.814 0.02
Sf)zcifg oPG OFF |50 0384 836.52 24.89 0.700 -0.01
51 0777 848.31 24.72 0.780 0.09
Edge # 2 - Pri 52 1013 824.7 24.87 0.108 -0.00
O et [ 53 0384 836.52 24.89 0.113 -0.18
54 0777 848.31 24.72 0.124 -0.02

NOTE: The measurement uncertainty of 23.2% was not added to the result.

The highest SAR level recorded was 0.814 mW/g as evaluated in a 1g cube of averaging mass. This value was
obtained in Lap Held 5mm Spacing position with DPC OFF in Ev-Do mode, utilizing channel 1013 (824.7 MHz).
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Table: SAR MEASUREMENT RESULTS — 1900MHz Ev-Do Rev.0

Table 44
Test Plot | Test Test Freq | Measured Measured 1g | Measured Drift
Position No. Channel | (MHz) average SAR Results (dB)
power (dBm) | (mW/g)
Lap Held 0 55 0025 1851.25 18.18 1.17 0.19
S‘:‘)gcifg DR ON 56 0600 1880 1811 1.34 0.11
57 1175 1908.75 18.05 1.14 0.07
L 58 0025 1851.25 23.46 1.10 0.15
ap Held Smm 50 | 0600 1880 2311 113 0.12
Spacing DPC OFF
60 1175 1908.75 22.94 0.782 0.06
Edge # 2 - Pri 61 0025 1851.25 23.46 0.880 -0.02
O et |62 0600 1880 2311 1.03 -0.01
63 1175 1908.75 22.94 0.822 -0.17

NOTE: The measurement uncertainty of 23.2% was not added to the result.

The highest SAR level recorded was 1.34 m\W/g as evaluated in a 1g cube of averaging mass. This value was
obtained in Lap Held Omm Spacing position with DPC ON in Ev-Do mode, utilizing channel 600 (1880 MHz).

12 COMPLIANCE STATEMENT

The Fujitsu Tablet PC, Model: Q702 with SIERRA WIRELESS Mini-PCl Wireless WAN Module (Gobi 3000),
Model MC8355 was found to comply with the FCC and RSS-102 SAR requirements.

The highest SAR level recorded was 1.58 mW/g for a 1g cube. This value was measured at 1735.4 MHz
(channel 1427) in the Lap Held Omm Spacing position with DPC ON in UMTS transmission mode. This was

below the limit of 1.6 mW/g for uncontrolled exposure, but was within the band of measurement uncertainty
around the limit.

13. MULTIBAND EVALUATION CONSIDERATIONS

No simultaneous transmission of WWAN and WLAN is possible for the Fujitsu Tablet PC, Model: Q702.
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